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ACCELERATOR USER GUIDE

Accelerator is a third-party add-on providing an integration between Outlook and Sage CRM. You can create Companies,
People, Opportunities, and Cases, as well as file emails, attachments, log call information, and tag outbound emails.
Accelerator is a great tool that provides an alternative to the standard Sage CRM Outlook Plugin.

Click here for Accelerator Training Videos
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Install Accelerator

1. If you already have a version of Accelerator, first uninstall the existing version under Add or Remove Programs

. Cortana If you already have the classic
Microsoft Corporation version, go to Add Remove

Programs > CRM Together
Outlook > Uninstall

E CREM Together Outlook

2.0.0.2

Modify Uninstall

Custom Mail Merge 1.2 (64-bit) 5.83 MB
3/20/2020

2. Close Outlook
3. Loginto Sage CRM and click My CRM —> Accelerator
4. Scroll down and select Click here to download, then follow the instructions to install the program

My CRM Team CRM ~

Dashboard Calendar Map CalendarList pashboard Jpportu

Accelerator  ID Generation = Calendar

—_— Map

My CRM for- [ sheila Campolieto v
Calendar List
Contacts
Your Accelerator Stats (today) Leads

Opportunities
Forecasts
Cases

Communications

E-mail Out Shared Documents
E-mail In
Groups
Phone Qut P
Phone In Mailchimp Campaigns
Accelerator
A
Help
Accelerator New » After downloading dose all
UI Outlook instances of MS Qutlook.
Integration » Run the install as your user
click here to {and not as administrator) and
- o then re-open Outlook.
download
» After
downloading
Click here to download and close all instances
- install the Accelerator M5 of M5 Outlook.
& Action Count Outlook Integration. » Run the install
Outlook and then re-open
Outlock.
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Your Accelerator Stats (Last Week)

EE'J CRMTogetherOutl....exe

&ErgTheme=0&Key0=... 7 O At the top in
[ Downloads ] S Edge
- CRMTogetherCutlookdddin (8).exe
' Open file
Select Setup Language X
Select the language to use during the
installation.
English w
Cancel
Setup ht

QJutlook needs to be closed in order to install CRM Together
QOutlook App Container,

Do you want to proceed?

ﬁ! Setup - CRM Tegether Outlook App Container 2.0.0.2 - X

Select Destination Location
Where should CRM Together Outlook App Container be installed?

Setup wil install CRM Together Outlook App Container into the following
folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

'M Together\TS Browse. ..

At least 8.5 MB of free disk space is required.
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ﬁl Setup - CRM Together Outlook App Container 2.0.0.2 — X

Ready to Install
Setup is now ready to begin instaling CRM Together Outlook App Container on
your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Wsers'sheil\AppData \Roaming\CRM Together {TSOutiookAddIn

ﬁ'_?j! Setup - CRM Together Outlock App Container 2.0.0.2 -

Completing the CRM Together
Outlook App Container Setup
Wizard

Setup has finished instaling CRM Together Outiook App
Container on your computer,

Click Finish to exit Setup.

5. Once the installation is finished, open Outlook and find the Accelerator icon in the top right corner of the Home
tab to open the Accelerator pane (this icon also closes the Accelerator pane)

Search People A}) HH_ R"‘ ’

@ Address Book

Read Get  [Accelerator Meet Schedule Insights
?FilterEmail* Aloud MNow  Meeting
Find Speech GoTaMeeting OneMote Add-in ~
Accelerator M
Y
SAGE CRM

Ned 5/19/2021 ... Inbox ﬁ' 0\
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Home Page & Settings

1. Home page gives you a quick glimpse into your Accelerator Activity, Case, and Opportunity Pipeline

SAGE CRM
A Q
Your Activity v
View the
Opportunity Pipeline ineli
Accelerator v X PP ty Pip I Pipeline
SAGE CRM
Cases Pipeline
fr Q e S+
Technical Evaluation | Submitted
Your Activity A~ On-Hold

Wl Aug Sep ©Oct MNov Dec lan Fabh  Mar  Apr  May

From the Home icon,
XN Your Activity represents

User's Accelerator

activity

Revised June 16, 2021 Www.mycrmmanager.com Page 5 of 32
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2. Settings allow you to check or update your connection, change the theme, and go back to the Accelerator pane

Your Activity

Aug Sep Ot Mov Dec  lan  Feb  Mar  Apr  May

Opportunity Pipeline

Cases Pipeline

A Q 7 T +

Accelerator for Sage CRM
Requires 'Accelerator for Sage
CRM server

CRM' installed on the

Click pencil icon to
check your

L P connection settings
Existing Connectigy

Sage CRM

Open Application

Open the

Select Theme @@ Accelerator pane

Font Sizee

—_—e

Customize the
appearance

Language

English NA -

Change

language

Revised June 16, 2021
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Accelerator Menu Buttons

By default, when you select an email, Accelerator will attempt to find a Person match in CRM using the email address in
the ‘From’ field. If there is no match, Accelerator will start to create a Company record by parsing the email. You can
continue to create the new Company and Person record, or search for and select an existing record.

1. Search Entities

a. Allows you to search for a CRM record

Accelerator ~—x || Accelerator v X

SAGE CRM
SAGE CRM

Select the

arrow

Accelerator v X
SAGE CRM
X T
Accelerator v X
SAGE CRM select
Company -
e
my crm manager Q Go
Select
Company Search results for: ‘'my crm manager’
Company Name
Person
Select the .4 My CRM Manager
| Lead enﬂw
Row: . — .
Cases Sl (lick Go or click on the
icon to access the
Opportunity record

Revised June 16, 2021 Www.mycrmmanager.com Page 7 of 32
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b. From the record you can save an email, log a phone call, see the CRM lists, or choose additional options
i Saving an email saves it as a Communication ‘Email In” against the current record (see Saving Emails
under Incoming Emails for more details)

. . .
- Sheila Campolieto

SAGE CRM

Email

Communications this year: 181

[ | Custom Fields

New email X

] = ]

From: Sheila Campolieto <sheila.campolieto@mycrmmanager.com> Summary [/

First Name:
Sheila

- Last Name:
Campolieto

To: Sheila Campolieto

This is the body of the emai
Company:

Sheila Campolieto B My CRM Manager
Title:

Project Manager

Project Manager

WWW.mycrmmanager.com
(M) 585.429.0870

‘ +/ Save H X Cancel ‘

ii. The phone icon allows you to enter a call and save it as a Communication record against the current
record by selecting Phone Out or Phone In, filling in the details of the call, then clicking Save

72 CRM Together x
_ Il

Accelerator

SAGE CRM

Py .
- April Braun

My CRM Manager

- Communications this year: 70

@® Phone Out Active Opportunities: 1
QO Phone In . & & ®
Subject .
Test Phone Qut F”‘_‘ Name:

Apil
Details Last Name:
Called April on 5.24.21 and left a message X 5] Braun

Company:

B My CRM Manager

Title:
Project Manager
“ Code:
Bl omeger
Additional:
August 5
- Phone
Details  Attachments  Communications
Task Test Phone Out
Regarding
‘Company: Person:
My CRM Manager April Braun & 980 3228102
About:
-None selected-
Details Scheduling
Action: Subject: Due DatelTime User:
Phone Out Test Phone Out 05/24/2021 2:35 PM Sheila Campolisto
Location: Start Date/Time
Details: Onscreen Reminder:
Called April on 5.24.21 and left a message.
Status: Priority: Territory: Reminder:
Complete Normal Worldwide Don't remind me

Revised June 16, 2021
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2. Record Menu

From the context of a selected record on the Accelerator pane, you can use Focus, New Task, Add Tag, Reply and
Tag, New Email, and New Appointment (see below for details about each)

SAGE CRM

I r

., Focus i
- S List from
Activ Summary page

Activ of a record

MNew Task
ﬁ -

Summary [;

¥ Add Tag
First NamE'!/

Dan
Last Name:
Cousins
_ Reply and Tag

Company:
My CR
Code: &5 New Email
Sage 100/
L _ & New Appointment

Bucinaze:

Revised June 16, 2021 Www.mycrmmanager.com Page 9 of 32
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a. Focus

Focus freezes the Accelerator Pane on a specific record. This is practical because you can then assign multiple
email messages to that CRM record without the pane changing during the automatic CRM search after each
selected email. Focus is indicated by a blue bar at the top. It must be manually released by selecting Release

Focus.

SAGE CRM

LRIV | ist from the
comr S
Actid Person's
Activ record

Mew Task

H

Accelerator T
SAGE CRM
A Q ®E T +
Dar
® My | . Release Focus | -
i Comi ]
Activ
Accelerator X
SAGE CRM

Revised June 16, 2021 Www.mycrmmanager.com Page 10 of 32
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b. New Task

New Task creates a Communication under the record that is displayed in the Accelerator pane.
SAGE CRM

® AUNON TR | (st from the 1
. Comi '
Actid Person's
Actiy record

MNew Task
£t "

7% CRM Together x
) .
Notes April Braun
. r P
Action
To Do -
Status
Complete v
Subject
Test Task from Accelerator 5.24.21
Details
This is a test task for the user guide. X
£
Summary Quick Look Marketing Notes JCommunications | Opportunities Cases Addresses Phone/E-mail  Self Service  Documents
E o~ Person: April Braun Phone: 980 322-8102
Company: My CRM Manager E-mail: april braun@mycrmmanager.com
4 Communications, Page 1 of 1
From the Communications tab, Action:
@ gigapﬁm graril\m Test Task from Accelerator 5 24 21 mi igsu?d«:sn task for the you can filter by_Act\on, Status, ToDo e
Subject, or Details to find the Status:
Task (or any Communication) Al e
Subject:
test
Details Aftachments  Communications
Task Test Task from Accelerator 5.24.21
Regarding
Company: Person:
My CRM Manager April Braun % 980 322-8102
About:
-None selected-
Details Scheduling
Action: Subject: Due Date/Time User:
To Do Test Task from Accelerator 5.24.21 0572412021 2:23 PM Sheila Campolieto
Location: Start Date/Time

Revised June 16, 2021 Www.mycrmmanager.com Page 11 of 32
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c. AddTag

Add Tag adds a reference number at the bottom of the email; the top banner of the Accelerator record turns
yellow and the Accelerator pane opens up each time you highlight the tagged email, and all responses; this can
be a Case ID or a randomly assigned number in the absence of a Case (i.e.: you receive an email that needs to
reference an existing CRM Case —> search for the Company, select the Case icon, find the Case, click on the small
Case icon, click Tag Email; the Case ID will be referenced)

d. Replyand Tag

Reply and Tag adds a reference number at the bottom of the email and replies to everyone on the email; the top
banner of the Accelerator record turns yellow and the Accelerator pane opens up each time you select the
tagged email or any responses

SAGE CRM

KHRSIEN | st from the

s Comi e
Activ Person's
Activ record

New Task

=

Summary [;

87 AddTag
First Nam‘é‘.‘f

Dan

Last Name:

Cousins 4 Reply and Tag

From: Sheila Campolieto <sheila.campolisto@mycrmmanager.com:s>

Sent: Tuesday, May 18, 2021 12:08 PM

To: Dan Cousins <dan.cousins@mycrmmanager.com>; April Braun <april.braun@mycrmmanager.com:
Subject: Test email

Test email with tag. Refer to the bottom of the email.

Sheila Campolieto
Project Manager ]
WWW.IMYCIrMImanager.com Tagis at the

(M) 585.429.0870 bottom of the

wgnornmj email

I Ref:#MCMIIXMZPTK# I

Revised June 16, 2021 WWW.mycrmmanager.com Page 12 of 32
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Accelerator

SAGE CRM

April Braun
® |
- Notice the color of the K
banner changes to yellow
when the email is tagged
< against the record ?
Accelerator VoS
SAGE CRM
L]
- Apt
ah My C . Focus ﬂ
Com)|
Remove tag
E from the
NEVRES S record under [i§
Summary [; options
First Name:
April ¥ Remove Tag

Www.mycrmmanager.com Page 13 of 32

Revised June 16, 2021


http://www.mycrmmanager.com/

@C Y m_J % CRMTogether

manager
Back to Contents

e. New Email

New Email opens a new email using the email address on the record you have open in Accelerator, removes the
default signature if there is one, adds a tag to the body, adds the person’s name to the Subject

SAGE CRM

List from the
Person's
record

MNew Task

2

Summary [
87 Add Tag
First Name:
Dan
Last Name:
Cousins Reply and Tag
Company:

My CR

Code: ¥ New Email
Sage 100/

File Message Insert Options Format Text Review Help Acrobat

Eﬁ Calibri Ju A A ELEC A :QS”

IE
B I U j??ﬁ\., Eg% = 5= Address Check

Paste
w @Fnrmat Painter Book Mames
Clipboard l= Basic Text I Mames
E Ta © April Braun
Send Cc

Subject April Braun
Ref:#MCMIIXMZPTK# Subject =

Person's
Adds a name
reference

number

Revised June 16, 2021 Www.mycrmmanager.com Page 14 of 32
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New Appointment must be created from the Person’s record on the Accelerator pane in order for it to save to
your CRM Calendar and under the Communications tab of the Person’s record
If you do not create the appointment from Accelerator, and just use the New Appointment button from Outlook,
you can use the ‘Link to CRM’ button on the calendar item and it will still show up under your CRM Calendar, but

will not be linked to a CRM record

Summary [;

First Name:
Dan

Last Name:
Cousins
Company:

My CR

Code:
Sage 100/30C

SAGE CRM

List from the
Person's
record

Mew Task

57 Add Tag

Reply and Tag

¥ New Email

End time

Location

Refi#MCMIIXMZPTK#

Title defaults to Person's

name and can be changed

Phone .
_ & New Appointment
Bucinges:
=l = April Braun - Appointment
File Appointment Scheduling Assistant Insert Format Text Review Help Q  Tell me what you want to do
m Calendar a * {é@) Qi, E Show As: DBusy - G EE EI HEZT3
Delete . Online Teams Add Invite - . . Recurrence | Categorize ~
—> Forward mafe Niting Mg Attendees Q Reminder: 15 minutes - Low Importance
Actions TeamViewer | Teams Meeting | GoToMeeting | Attendees Options Tags
e I Titl April Braun I q ;
= 2 Invite Attendees will default
Save & e
Close Stert time SR ls] (o the Person’s record you

created the Appointment

from, but you can add more

| High Importance

O | E = &

Dictate | [Linkto|Address  Shared
CRM | Book Documents

Voice CRM Together

Accelerator

before save/send

+**+**powered by CRMTogether.com™*****33afec6f-0563-49cc-5ffa-1b7da3d104ab******crm.dcaa.ca** ****Do not Remove

DO NOT REMOVE THIS
REFERENCE NUMBER, IT IS
REQUIRED FOR THE
RECORD TO SAVE IN CRM

Revised June 16, 2021
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File Meeting Scheduling Assistant Insert Format Text Review Help Q  Tell me what you want to do
. 0 Address Book EO (& 3
m Q % & [O 8w Sooves Wy - O B 8 |1 B ﬁ"‘l @ D 0
Delete _, . | Online Teams Add Cancel P Check Names £\ Rerinder: [15 mimges +|Recumence | Ctegorize | Dictate | |Linkto | Address \Accelerator| [Meeting | Insights | View
Meeting Mezting Meeting | Invitation L] Response Options ~ - ~ ¢ CRM | Book Documel Notes Templates
Actions TeamViewer | Teams Meeting | GoToMeeting Attendees Options Tags Voice CRM Togeth IoneNote | Add-in | My Templates A
You haven't sent this meeting invitation yet.
®Tms appointment conflicts with another one on your calendar. Accelerator - X
= Title Meeting SAGE CRM
Send Required | ® Sheils Campolieto <sheila -
Optional My CRM Manag
Dan Cousins N "
Startt Tue 5/25/2021 400 PM Alld T ’ 7 New Tas
erime & - o oy O @ Trmezoncs ﬁ Communications this y€
End time Tue 5/25/2021 (5] | s00Pm w| 4 Make Recurring Active Cases: 8
Active Opportunities: 3
Location i I - bl
You can attach a document from CRM to a < i3] s @7 Attach file
New Appointment by following these steps: —_—
Summary [
*==s=>*powered by CRMTogether.com™**=**b0b5a448-6ed4-4c3f-b269-7aa2179 ,_ _ -
Click Accelerator icon > click the Options & AddT:
. . i 7 ag
Ref:HMCMIIXMZFLP# icon > click Attach File Company Name:
My CRM Manager

7% CRM Together

[{) Select documents to attach and click okay

invoice|

File

SMITH31 Sage CRM
service invoice Jan
2.2020.pdf
SMITH30 Sage CRM
service invoice Dec
3.2019.pdf

Description

Enter the key word(s) int

the search bar and click
the magnifying glass

1-20f 2

Format Text Review Help Q Tell me what you want to do

File Meeting Scheduling Assistant Insert
— . 0
U] @ & &
Delete . Online Teams Add
Meeting | Meeting Meeting
Actions TeamViewer Teams Meeting | GoToMeeti
() You haven't sent this meeting invitation yet.
This appointment conflicts with another one on youl
B Title Meeting
Send Required | @ Sheils Campolietd
Optional
Start time Tue 5/25/2021
End time Tue 5/25/2021
Location /

SMITH31 Sage CRM service invaice Jan 3.202(
68 KB

*=**=*powered by CRMTogether.com******b0b.

Ref:#MCMIIXMZFLP#

#% CRM Together

Select documents to attach and click okay

invoice|

Click the paper clip
to preview the
document

File Description

SMITH31 Sage CRM
service invoice Jan
3.2020.pdf

SMITH30 Sage CRM
service invoice Dec

3.2019.pdf
? Highlight the

document you
want to attached to

the New
Appointment

SMITH31 Sage CRM...pd?
Cpenfile

X Close

Revised June 16, 2021
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The Accelerator icons display the CRM lists under the selected record. For example, you can see the list of
People, Communications, or Cases under a Company record.

fr Q

P
Active

My CRM Manager

Dan Cousins
Communications this year: 489

Active Cases: 8

Opportunities: 3

<

+ O

< =

P
Active

<

W

My CRM Manager

Dan Cousins
Communications this ye
Active Cases: 8 P

Opportunities:

eople List

Person Status
Active

Last N
First Name astiame
[ ]
o 0
ril Braun
Displays more
Company: details
My CRM Manager
Person Status: Opens
Active record in
Accelerator
v Opens Campolieto
record in
CRM
e Crniging

Revised June 16, 2021
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Accelerator

SAGE CRM

Select

Person

Accelerator

SAGE CRM

List of options

from Search
page

e M Bookmarks

april braun

o

© History

Search results for: ‘dan.cousir

Entity
Parse Email
person S

company

£d

Revised June 16, 2021

www.mycrmmanager.com

Page 18 of 32


http://www.mycrmmanager.com/

(myermy

a. Bookmarks

@ CRMTogether

Back to Contents

Bookmarks list all the records that have been bookmarked

Accelerator Voo
SAGE CRM
When you click Accelerator v X
Select on Bookmarks, SAGE CRM
Company you can see the
list of records A Q 1 Y O+ &%
you bookmarked
Dan Cousins
® My CRM Manager
Search results for: 'Bookmarks' i Communications this year: 180
Entity Name Active Cases: 5
Active Opporgi
Click here to
i Company DCAA - My CRM Manager ¢ ﬁ bookmark a 3
record
. Vivekanandan (Vivek) -
- Person . First Name:
Ravindran
18-030/Company Dan
= Opportunit :
(= pportunity A/11/20/2018 Last .Name
Cousins
b. History

History allows you to search for and select a record based on entity and date

(5 Your View History
want to search

Entity Name

Person

Company

Cases

Choose the entity you

Title

Sheila Campolieto
Sage North America

Install CRM and Sage's 100 integration

Rows per page M0 -

Cli

want to search

in the Accelerator pane

Choose the date you

Click to view the record
in the Accelerator pane

ck to view the record

X Cancel
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c. Parse Search

Parse Search searches all email addresses associated with the selected email
~ Andy Shapiro SAGE CRM

Select the email

~  April Braun \/
P
April Braun Fri 6/4
el
April Braun 5/18/2021 H
Filed © ] 0 o] J

~ Andy Shapiro SAGE CRM

~ April Braun
<j Select
April Braun Fri 6/4 Company
Click icon for
= more options
April Braun 5/18/2021
Filed kD) @ History
April Braun 5/18/2021
Entity
April Braun 12/31/2020
Parse Email
Filed . a person

7 CRM Together

r‘q Select one of these addresses for the system to use

Email
april.braun@mycrmmanager.com Select the email address
© associated with the record
heila.c ligto@mmy . g
shella.campolietol@mycrmmanager.com VOU Want to ﬂ|e the ema” to

dan.cousins@mycrmmanager.com

d. LogOff

Logs you out of Accelerator

SAGE CRM
Login
@ https://crm.dcaa.ca/crm/ X
Username
8 sheila

L

Remember Me

Revised June 16, 2021 Www.mycrmmanager.com Page 20 of 32



http://www.mycrmmanager.com/

@E‘ qrn!;!r‘_] @ CRMTogether

Back to Contents
5. Create New Records

a. The plus symbol allows you to create a new record based on the data in the email (a best practice for
new Person, Opportunity, or Case is to first go to the appropriate Company record and then create the
new record)

b. You can also create a new Company, regardless of the email you have highlighted, and remove all of the
pre-populated informaiton

Accelerator v X

SAGE CRM

Click the + symbol
to create a new

i3] record (if you are
creating it from
Summary [ the Company, it
[=“RPeE pulls in the

Company N Company

My CRM Ma information)

Website:

http://www.i B Cases

Status:

Active

Type:

Supplier I=1 Opportunity
Accelerator vx

New Person

B Company

If you are creating a
Person, you must use the

First Name

enter key to get the list of
possible matches after
typing in the name

Sheila

Last Name

Campolieto

PossiblePersonMatch

Sheila Campolieto (My CRM Manager)
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Incoming Emails

1. Email Matching

When an email is received, Accelerator will search CRM based on a tag reference, or the email address in the
‘From’ field, and display the Person record in the Accelerator pane. Accelerator attempts to match the email in
the following order:

Tag — checks for a tag and if there is, searches CRM based on the tag
Person Email — checks for a Person record with a matching email address
Company Email — checks for a Company record with matching domain
Lead Email — checks for a Lead record with a matching email address
If no match is found — checks for a matching domain under a Person record, if there is a single match,
Accelerator shows that Person’s Company
2. Saving Emails
a. From your Inbox, click on the email you want to file (do not open it)
b. Confirm the record in the Accelerator Pane is correct
c. Select Save Email button
i. If you save to a Person, it also saves to the Company that the Person is under
ii. If you save to a Company, Case, or Oppo, it also saves to a Person record that has an exact
match to the email address in the ‘From’ field

Poo Ty

D o Jcrmst. [From = [subjeat [Received in Folder -

v

SAGE CRM

Sheila Campolieto
My CRM Manager
Communications this year: 180

Beila O lielgedilemis. 2 uniead

|
lI Sheila Campolieto Wed 6/2/2021... Inbox I L d

. . .
- Sheila Campolieto

Email
- Custom Fields
Test email X
E  Documents
This is the record From: Sheila Campolieto <sheila.campolieto@mycrmmanager.com=
that the email will
be filed under To: Sheila Campolieto

o i ;
Ermail - Sheila Campolieto

A Custom Fields

Priority

Use the drop down

ol arrows to change the
=] Documents ;
options for any
Team %
Default Custom Fields
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iii. Documents — allows you to specify the Communication record attributes (the fields displayed
here can be customized to your CRM documents)

7 CRM Together X

. . .
Email Sheila Campolieto
- Custom Fields =
ype
E-mail Attachment -
a Documents
Category -
Status
Final -
Use the drop d
se the drop down Ves .
arrows to change the
options for fields related
to attachments Team v
v Save X Cancel
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Outgoing Emails

1. New Email using the Accelerator pane
a.
the email under before using Send and Save or Prompt a
b. If you are using an email template with merge fields, you

work (i.e. pull in the Person’s first name)

% CRMTogether

Back to Contents

You can open the Accelerator pane from a new email to search for and select the record you want to file

nd Sent
must first select the record for the merge to

From the new email, click on the CRM Together icon —> Accelerator —> Search —> Select —> Person (or

Company) —> enter name of Person (or Company) —> Go
one result)

Untitled - Message (HTML)

(click icon to select record if there is more than

File Message Insert Options Format Text Review Help Acrobat Q Tell me what you want to do
A a =iz A Q[ AttachFile~ . LE' M ¥ Q
g wulz-on| B 88 » = ) G
Paste — | p ule. A = = = o= o= | Address Check ) Attach File | Assign Dictat: CRM Insights View
~ F - = - — = Book Names | |2 Signature via Link ~ Policy ~ Together ~ Templates
Clipboard T Basic Text Names Include Adobe Acrobat Tags Nl Voice Add-in | My Templates
> > (2 =
To E BTV R R
P Send  Prompt Address  Shared Email  Accelerator
Send e and Save and Send Book Documents Templates
CRM Together
Subject
Accelerator %
Accelerator v
SAGE CRM
SAGE CRM
X + %
Select
. Person v
Your Activity = —
sheila cam Go
P L Q

Test email - Message (HTML)

File

CRM Together box and select

'Send and Save' or 'Prompt and
Send’ (the second option
produces a pop up box)

—_—

Sheila Campolieto
Project Manager
WwWW.mycrmmanager.com

Message Insert QOptions Format Text Review Help Acrobat Q Tell me what you want to do
ﬁ] e e A P P 8 ) Attsch Fie » LElEI Pl g 5 ®) [';
0 — @ Link ~ ) - | ]
Paste B I U £+ A« o= 5= | Address Check ) Attach File | Assign ~ Dictat} CRM Insights View
~ - - - Book Mames | |2 Signature - via Link ~ Policy ~ Together~ Templates
Clipboard T Basic Text N Names Include Adobe Acrobat Tags N Voicel Add-in | My Templates
(ot =
&
To Sheila Campolieto: Acceleratgr {?)I (f:o] |4' % = ’ f
} Send  Prompt Address  Shared Email  Accelerator
Send I Populate the To SUbjECt and and Save and Send Book Documents Templates
c s - 2
5 - CRM Togeth
Body of the email, then click the Sl -
Subject  Test email

f

Q

+ @
Sheila Campolieto
My CRM Manager
Communications this year: 180
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2.  New Email without the Accelerator pane

You can use the Accelerator buttons from an email without opening the Accelerator pane

a. Send and File
Send and File sends the email and files it to CRM if the email address in the To field matches an email address in
CRM (see Email Matching under Incoming Emails for more details)

b. Prompt and Send

Prompt and Send sends the email and files it to CRM if the email address in the To field matches an email address
in CRM (see Email Matching under Incoming Emails for more details)

Untitled - Message (HTML)

File Message Insert QOptions Format Text Review Developer Help Acrobat Q  Tell me what you want to do
1A A~ av = L 1= A . QD AttachFile~ . LE| . s \D D
in M oA=L E e > = 0 2 4
Paste BT U|#L- A — = = o= o= | Address Check ) Attach File | Assign ~ Dictate CRM Insights View
- - = - — == Book Names | |2 Signature via Link ~ Policy ~ Together Templates
Clipboard Basic Text Names Include Adobe Acrobat Tags ~l o Voice Add-in | My Templates ~
ot =
LY =
To Sheila - Gmail Acct; (‘5‘ @ B @ = ’
E Send  Prompt Address Shared Email  Accelerator
Send e and Save and Send Book Documents Templates
CRM Together
Subject Test email without a record

Sheila Campolieto
Project Manager
WWW.mycrmmanager.com
(M) 585.429.0870

(myerm)

2 CRM Together

Email S sheila Qureshi

B Custom Fields Prompt and Send

produces a pop up box so
you can confirm the
From: <sheila.campolieto@mycrmmanager.com> UCSCRUEICRCVNEAUE
email to, based on the

To: Sheila - Gmail Acct email address

test
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NOTE: If there is no email address match in CRM, and you use Send and File, the email will not be filed to a

specific record and there will be no ‘warning’ message letting you know. The email will instead be saved as an
orphaned email (i.e. not saved under any Company or Person).

You can find orphaned emails under Find —> Communication and use the search fields, such as ‘Created Date’,
‘Created By’, or the ‘Email Address’.

u | Find: [Communication v] |

Find

Type: Action:
—All-- hd

Status:
—All-- v —-All-- hd
Company Name:

. . First Name:
To find orphaned emails, search
Subject: by Created Date & Created By
Date / Time: Created Date:
Between v @ And O] Between v (03232021 (@) And 03232021 | ()
Created By:
Sheila Campolieto v These are the

orphaned emails

2 Related communications, Page 1 of 1

[ Touermme v o ane P R T T

03/23/2021 . 03/23/2021 .

318 PM E-mail Out test 319 PM Worldwide

03/23/2021 - 03/23/2021 " .
@ 335 PM E-mail Out 2nd test 395 PM Worldwide
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You can use your CRM data to find email addresses by filter

7% CRM Together

Review Help
2 5

Address Check
Book Names

Names

File Message Insert Options Format Text
ﬁ‘] A A A==
"ﬂfmrg BILU|Z-A-|=E==|=
Clipboard & Basic Text
)> To
Send Cc
Subject

Untitled - Message (HTML)

Acrobat Q  Tell me whal
B Attch File v .
» p
Attach File
[ signature ~ via Link ~
Include

Adobe Acrobat

t you want to do

i Y 0
=r| 8 > B
Assign Dictats CRM Insights View
Policy ~ -, Together Templates
Tags | Voice Add-in | My Templates
-
GIC-S T I . 4
Send  Prompt Address  Shared Email  Accelerator
and Save and Send Book Documents Templates
1 CRM Together .

m Search your CRM Address Book

Q, sheila camp|

Person

Email Address

Sheila Campolieto

Sheila Campolieto

d. Shared Documents

sheilag35@gmail.com

sheila.campolieto@mycrmmanager.com

Search and
select email (can
add to To, Cc, or
Bcc)

You can select Shared Documents that are saved in CRM and attach them to an outgoing email

File Message Insert Options Format Text
[ [)‘D A A A
P gl B I U[Z-A-|[SE=S|ES
Clipboard = Basic Text
B To
Send Ce
Subject

#1 CRM Together

Review

Untitled - Message (HTML)

Help Acrobat Q  Tell me what you want to do
Q Q[ Attach File . F fo . [ \D D
o ars A 50 8 J I
Address Check Attach File | Assign Dictat CRM Insights View
Book Names |2 Signature vialink~ | Policy ~ Tagether - Templates
Mames Include Adobe Acrobat Tags Ml Vaoice Add-in | My Templates
= -
LS O = R T

Send

Prompt Address  Shared Email

Accelerator
and Save and Send Book Documents Templates

1 CRM Together

Select documents to attach and click okay

accelerator]

File

Accelerator and Active - 11 5 18_Sheila.csv

- =
Search and
Accelerator_User_Guide.pdf select document (=]
Accelerator_User_Guide_7-12-19.pdf =

Description
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You can access email templates saved in CRM, with saved attachment(s) if applicable; allows you to

select and send from Outlook (if there are merge fields, you must first select the appropriate entity and
record — see New Email under Qutgoing Emails for more details)

ke [~ Untitled - Message (HTML)
File Message Insert Options Format Text Review Help Acrobat Q  Tell me what you want to do
X A A= H Q | D AttachFie~ . LE| B 0 ¥ Q D
A= A e e
K o 8l &8 o A = | P D) §
Paste B I U|#£. A.|=== = 5= | Addres Check ) Attach File | Assign Dictat CRM Insights View
- ¥ - = = = = = | GBook Nemes & Signature~ vialink~ | Policy~ < Together ~ Templates
Clipboard ™ Basic Text Names Include Adobe Acrobat Tags [l Voice Add-in | My Templates
o
™ ST VR R I
)> _ Send Prompt Address Shared Email Accelerator
Send c and Save and Send Book Documents Templates
c
CRM Together
Subject
7% CRM Together

E My CRM Manager

Select an email template

kick] Q,
Email Templates
50 - Kick Start Search and (5]
select email
IT - Kick-start template 2
0 - 1-20f2
X Close
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Viewing Accelerator on the Outlook Screen

1. Outlook Layout

To change the layout of the Outlook screen to accommodate the addition of the new Accelerator Pane (which
opens on the right side), select the View tab and click on Reading Pane and choose Bottom

= = P Search o= = [m]
File Home  Send / Receive o View eveloper  Add-ins  Help  CRMTogether  Acrobat
} -_— — —
B9 “ lremtn | 1= | [RCE | e
oo ~ | 51 Add Columns = [ ppen inl3ew Window
Change View e Show Focused | Message [ 7o BB Categories - Use Tighter Foldd [Reading| To-Do [
View > Settings = Inbox Preview~ = += Expand/Collapse ¥ Spacing Pancl | Pane~ | Bar~ | [CxfFlose All ltems
Current View Messages Focused Inbox Arrangement bt [ Right Window A~
~Favorites All - Unread ByFrom~ | Accel Bottom - x
Inbox 9 ~ April Braun - [ o
Drafts 149] Options...
Sent ltems 6 April Braun 10:43 AM
Outbox
e) .
April Braun 518/2021 Apr|| Braun
o My CRM Manager "
Filed 2] - Communications this year: 96
April Braun 51812021 ) P e
Active Oppertunities: 1
n
FW: = ] = d
April Braun Reading Pane Summary [
To @ Sheila Campolieto 0:43 AM
First Name:

2. CRM Status for Inbox

NOTE: This status field is only displayed after the first email has been saved/stored in CRM
To display the CRM Status column (if an email has already been filed using Accelerator):

a. Select the View tab
b. Click on Add Columns:

File Home Send / Receive a Add-ins Help Q Tell me what you want to do
= - ~ ]
Q {?‘ i Show as Conversations J = Date (Conversations) 12 Erom 52 To 1l Categories 1] Reverse Sort
; > > - = - =] Add Columns
Change View Resel | > conyersation Settings - Show | Message ™ flag; Start Date 1™ Flag: Due Date = = subject = e
View = Settings View Focused Inbox  Preview - Expand/Collapse ~
Current View Messages Focused Inbaox Arrangement

c. Choose User-defined fields in Inbox from the available columns drop-down and select CRM Status
d. Select Add and then move the CRM Status field toward the top of the list

Show Columns X
Show Columns K Maximum number of lines in compact mode: | 2 |~ o
Maximum number of lines in compact mode: 2 |« o SElEE TEIFHE e (T
Select available columns from:

Available columns: Show these columns in this arder:

User-defined fields in Inh(|
Available columns: Show these columns in this order: Add -> :’I:I;Enci':ggrce

CRM Status Add -> Importance lcan
:‘«‘czr:mder <= [EEOTE CRM Status
Flag Status Attachment

Attachment Mew Column...
Mew Column Fram From
w1 subject Subject
Received Received
Size Size
Categories Categories
Mention Mention

Properties Delete Move Down Properties Delete Move Up Move Down
oK Cancel Cancel
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You can add CRM Status column to each subfolder individually or create a new view that adds the status field to

all subfolders already created. To create a new view:

Click View tab

Change View

Manage Views

New

Enter a name for new view

I O - N -

Columns

Check the box for All Mail and Post folders —> OK

File

Send f Receive

Show as Conversations

(®) All Mail and Post folders
Filter:
| — |

Reset Current View

. . 5 -
PE] Conversation Settings ~ Manage All Views X
Facus
Views for folder “Inbox™:
Facus View Name Can Be Used On Wiew Typﬂ New..,
<Current view settings> All Mail and Post folders Table
) - SentTo All Mail and Post folders Table Copy..
Sent Ta Mj" View 5C Mew Vi, Co mp act My View All Mail and Post folders Table -
SC New View All Mail and Post folders Table Modify...
= ~ U nrea| ||Compact All Mail and Post folders Table
‘Qa Rename...
=l G Single All Mail and Post folders Table
Sin E|||-: Preview 3 w | Preview All Mail and Post folders Table Delete
r
Manage Views... Q Description
Fields: Importance, Reminder, lcon, Attachment, CRM Status, From, 5
Views for folder X"
View Mame| Create a New View =
<Current view setti
Sent To Mame of new view: - - -
- Advanced View Settings: Mame of New View p
My View | Mame of New View |
SC Mew View Type of view: Description
Compact Table ~ rlam:e, Reminder, lcon, Flag Status, Attachment, Fr...
Single Timeline
- Card Group By... Mone
Preview -
Business Card
People Sort... Received [descending)
DayWeek/Month
— lcon Il Filter... off
gscription Business Card
Fields: Table ¥ | RM 5 Other Settings... Fonts and other Table View settings
Can be used on
Group By: . . ion Conditional Formatting... | User defined fonts on each message
L OTmsfoIder, visible to everyone
Sort: OThiSfOldEl’, visible anly to me Format Columns... Specify the display formats for each field

OK Cancel
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h. Scroll down to User-defined fields in Inbox
i. Select CRM Status
j. Add
k. Select CRM Status and click Move Up to place the CRM Status column where you choose —> OK
I.  Select the new view just created
m. Apply View (this applies the view to the highlighted folder, continue to next steps to apply view to all)

Views for folder "Inbox™:
View Name Can Be Used On View Type
<Current view settings> All Mail and Post folders Table
Sent To All Mail and Post folders Table
My View All Mail and Post folders. Table
Maxi ber of lines &t mode: |2 SC New View Al'Mail and Post folders Table
AL RS oy LT ) (L R = Compact All Mail and Post folders Table
Select available columns from: Single Al Mail and Post folders [ Table
User-defined fields in Inb(|° Preview All Mail and Post folders Table
Available columns: Show these columns in this order:
CR Comm ID rtance Description
CRM Filed By inder i :
CRM Filed Entity lcon Fields: Impartance, Reminder, lcon, Flag Status, Attachm
CRM Filed Ta == RETE Flag Status
| CRUIF Aty ;\ttachment Group By: Mone
e ntr rom
CRMFiledTolD LS S Subject . .
GZM-Meeting Received Sort: Received [descending)
Size
Categories Filter: Off
| Mention
|:| Only show views created for this folder
Properties Delete _ Maove Down 0K I | Apply View |°]55

View tab

Change View

Select new view

Apply Current View to Other Mail Folders

Check the box for the main folder

Check the box for Apply view to subfolders —> OK (all folders and subfolders should now have the CRM
Status column visible)

» 52T 0>

Apply View >

Apply View to These Folders:

File Home Send / Receive Foo View Add-ins ™= Inbox (13}
1] TEST FOLDER (19] Cancel
Z/ Show as Conversations @/ W DD ACI [130)
N £y Conversation Settings ~ Show DD Reports and Forms (2] Clear All
Settings Focused Inbox DD Acitve Exhaust
Focused Inbox DD ACMS (2
I ] American Ripener (3]
Sent To My View SC New Vi... DD Antek
E: Mame of New View Nread g% i::.:ll:ll
Compact Single ]_@ From DD Basecamp (1]
' ] c2 Education o
Manage Views... —E— el L.
Vivek Ravin{ || € >

Save Current View As a Mew View...

[} vivek Ravin{ |[+] Apply view to subfolders

o el St (s L U T PRl [l vivek Ravin{ |Number of folders to apply the view to: 1
E sheila.campolieto @ mycrmmanaaer.com
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If you later create a new folder, you can apply your new view to by selecting the new folder and completing
steps n, o, and p from above.

Additional information about filed emails available in Outlook (hover over the columns then right click —>
Field Chooser —> user-defined fields in Inbox —> scroll and select)

All  Unread
WO (@ | CRM Status
v Today User-defined fields in Inbox |«
CRM Comm 1D All Unread
| CRM Filed By P - . . i
i CRM Filed Entity Wik | O [l QcrM Status CRM Filed By CRM Filed Entity From
CRM Filed To N - ﬁ Filed Sheila Campoli... Person
CRM Filed To ID 0
CRMFiledEntity | [
CRMFilzdTolD Ap]

Please contact your Project Manager if you have questions as you begin utilizing the integration. Be sure to include details
and a screen shot of the question/issue so we can quickly investigate a resolution.

dan.cousins@mycrmmanager.com | april.braun@mycrmmanager.com | sheila.campolieto@mycrmmanager.com
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